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Driver for Serial Communication  
with Devices Using EAP (Agri) Protocol 
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Introduction 

The AGRI driver enables communication between the Studio system and AGRI devices using the EAP protocol 

communicating over Serial, according to the specifications discussed in this document.  

This document was designed to help you install, configure, and execute the AGRI driver to enable communication 

with these devices. The information in this document is organized as follows: 

 Introduction: Provides an overview of the AGRI driver documentation. 

 General Information: Provides information needed to identify all the required components (hardware and 

software) used to implement communication between Studio and the AGRI driver.  

 Installing the Driver: Explains how to install the AGRI driver. 

 Configuring the Driver: Explains how to configure the AGRI driver. 

 Executing the Driver: Explains how to execute the driver to verify that you installed and configured the  

driver correctly.    

 Troubleshooting: Lists the most common error codes for this protocol and explains how to fix these errors. 

 Sample Application: Explains how to use a sample application to test the AGRI driver configuration. 

 Revision History: Provides a log of all modifications made to the driver and the documentation.  

 Notes:  

• This document assumes that you have read the “Development Environment” chapter in the Studio 
Technical Reference Manual. 

• This document also assumes that you are familiar with the Windows NT/2000/XP environment.  
If you are unfamiliar with Windows NT/2000/XP, we suggest using the Help feature (available from the 
Windows desktop Start menu) as you work through this guide.  
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General Information 

This chapter explains how to identify all the hardware and software components used to implement 

communication between the Studio AGRI driver and the AGRI devices. 

The information is organized into the following sections: 

 Device Characteristics 
 Link Characteristics 
 Driver Characteristics 

Device Characteristics 

To establish communication, you must use devices with the following specifications:  

 Manufacturer: Agri-Datalog 
 Compatible Equipment:  

- CS950 series 
- AC2500 (only short parameter form) 
- EC100 
- CPM8 
- Any device that is fully compatible with the EAP protocol through serial communication 

Link Characteristics 

To establish communication, you must use links with the following specifications: 

 Physical Protocol: RS485 (RS232 x RS485 converter needed) Serial 

 Logic Protocol: EAP  

 Device Runtime Software: None 

 Specific PC Board: None 

Driver Characteristics 

The AGRI driver is composed of the following files: 

 AGRI.INI: Internal driver file. You must not modify this file. 

 AGRI.MSG: Internal driver file containing error messages for each error code. You must not modify this file.  

 AGRI.PDF: Document providing detailed information about the AGRI driver 

 AGRI.DLL: Compiled driver 

 





Notes:  

• All of the preceding files are installed in the /DRV subdirectory of the Studio installation directory.  

• You must use Adobe Acrobat® Reader™ (provided on the Studio installation CD-ROM) to view  
the AGRI.PDF document. 

 

You can use the AGRI driver on the following operating systems:  

 Windows 9x 

 Windows 2000 

 Windows NT 
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Conformance Testing 

The following hardware/software was used for conformance testing: 

 Driver Configuration: 

 PLC Program: N/A 

 Modbus Port: N/A 

 Baud Rate: 9600 

 Protocol: EAP 

 Data Bits: 8 

 Stop Bits: 1 

 Parity: None 

 COM Port: COM1 

Driver 

Version 

Studio 

Version 

Operating System 

(Development) 

Operating System 

(Target) 
Equipment 

1.04 6.1 
Windows 

NT/2000/XP 

Windows 

NT/2000/XP 

Equipment: CS950A with an Intercom 

RS232xRS485 converter. 
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Installing the Driver 

When you install Studio version 5.1 or higher, all of the communication drivers are installed automatically.  

You must select the driver that is appropriate for the application you are using. 

Perform the following steps to select the driver from within the application: 

1. Open Studio from the Start menu.  

2. From the Studio main menu bar, select File Open Project to open your application. 

3. Select Insert Driver from the main menu bar to open the Communication drivers dialog.  

4. Select the AGRI driver from the Available Drivers list (as shown in the following figure), and then click the 
Select button. 

 

Communication Drivers Dialog Box 

5. When the AGRI driver displays in the Selected Drivers list, click the OK button to close the dialog. 

 

 Note:    

It is not necessary to install any other software on your computer to enable communication between the 
host and the device. However, to download the custom program to your device, you must install the 
AGRI programmer. Consult your AGRI programmer software documentation for installation instructions. 

 
 

 Attention:    

For safety reasons, you must use special precautions when installing the physical hardware. Consult the 
hardware manufacturer’s documentation for specific instructions in this area. 
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Configuring the Driver  

After opening Studio and selecting the AGRI driver, you must configure the driver. Configuring the AGRI driver is 

done in two parts: 

 Specifying communication parameters 

 Defining tags and controls in the STANDARD DRIVER SHEETs (or Communication tables) 

Worksheets are divided into two sections, a Header and a Body. The fields contained in these two sections 

are standard for all communications drivers — except the Station, Header and Address fields, which are driver-

specific. This document explains how to configure the Station, Header and Address fields only. 

 

 Note:    

For a detailed description of the Studio STANDARD DRIVER SHEETs, and information about configuring 
the standard fields, review the product’s Technical Reference Manual.   

 

Setting the Communication Parameters 

Use the following steps to configure the communication parameters, which are valid for all driver worksheets 
configured in the system: 

1. From the Studio development environment, select the Comm tab located below the Workspace. 
2. Click on the Drivers folder in the Workspace to expand the folder.  
3. Right-click on the AGRI subfolder. When the pop-up menu displays (as shown in the following figure), select 

the Settings option. 

 

Select Settings from the Pop-Up Menu 

The AGRI: Communications Parameters dialog displays (as follows). 

 

Communication Parameters Dialog 
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4. Specify the parameters as noted in the following table: 

 

Parameters Default 
Values 

Valid Values Description 

Station 0 252 to 254 Address for PC Studio station. 
 
 

 Note:    

The device must be configured with exactly the same parameters that you configured in the AGRI 

Communication Parameters dialog.  

 

5. Click the Advanced button on the Communication Parameters dialog to open the Advanced Settings dialog and 

configure the necessary settings. 
 

 Notes:    

 Do not change any of the other Advanced parameters at this time. You can consult the Studio 
Technical Reference Manual for information about configuring these parameters for future reference. 

 Generally, you must change the Advanced parameter settings if you are using a DCE (Data 
Communication Equipment) converter (232/485 for example), modem, and so forth between the  
PC, the driver and the host. You must be familiar with the DCE specifications before adjusting these 
configuration parameters.  
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Configuring the Driver Worksheets 

This section explains how to configure the STANDARD DRIVER SHEETs (or communication tables) to associate 

application tags with the device addresses. You can configure multiple Driver Worksheets — each of which is 

divided into a Header section and Body section.  

Configuring the STANDARD DRIVER SHEET 

 

Use the following steps to create a new STANDARD DRIVER SHEET: 

1. From the Studio development environment, select the Comm tab, located below the Workspace pane. 

2. In the Workspace pane, expand the Drivers folder and right-click the AGRI subfolder.  

3. When the pop-up menu displays (as shown in the following figure), select the Insert option. 

 

Inserting a New Worksheet 

 

 Note:  

To optimize communication and ensure better system performance, you must tie the tags in different 

driver worksheets to the events that trigger communication between each tag group and the period in 

which each tag group must be read or written. Also, we recommend configuring the communication 

addresses in sequential blocks to improve performance. 
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The STANDARD DRIVER SHEET displays (similar to the following figure). 

 

STANDARD DRIVER SHEET 

In general, all parameters on the Driver Worksheet (except the Station, Header, and Address fields) are standard 

for all communication drivers, but they will not be discussed in this document. For detailed information about 

configuring the standard parameters, consult the Studio Technical Reference Manual.  

4. Use the following information to complete the Station, Header and Address fields on this worksheet.  

Station field: The following device addresses are predefined for use with EAP-devices: 

 

Device Address (hex) Address (dec) 

<broadcast> 00 0 

CS-950  01-6F 1-111 

Reserved 70-CF 112-207 

CDS-03  D0-DF 208-223 

CMP-08  E0-EF 224-239 

Reserved  F0 240 

AC-2500 F1-F7 241-247 

EC-100 F8 248 

Reserved F9-FB 249-251 

PC FC-FE 252-254 

Reserved FF 255 
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Header field: Defines the type of variable to be read or written from or to the device, and the reference of the 
initial address. These variables must comply with the following syntax: 

CS-950 or AC2500 or EC-100 orCMP-08 

After you edit the Header parameter, the system checks the syntax. If the syntax is invalid, Studio 

automatically inserts the default value (DINT) into the Header field. 

Also, you can type a tag string in brackets {Tag} into the Header field, but you must be certain that the tag’s 

value is correct and that you are using the correct syntax, or you will get an Invalid Header error.  

Address field: Use the information in the next table to associate each tag to its respective device address.  

Type the tag from your application database into the Tag Name column. This tag will receive values from or 
send values to an address on the device. The address must comply with the following syntax: 

 <Register Number>.<Length> 

CELLOSTAT CS950A/G 

PC Name Cat. Length Description 

00H PING E - Test if device is ready, empty reply 

01H RESET E - Reset the device 

03H PORT M 2 State of the output ports 

04H STATUS M 1 State of the device 

06H STORE E - Store parameters to the eeprom 

10H T1 M 2 Temperature T1 all in 1/10 C 

11H T2 M 2 Temperature T2 

12H TV M 2 Temperature TV (only CS-950A) 

13H TGV M 2 Temperature TGV (only CS-950G) 

14H TGR M 2 Temperature TGR (only CS-950G) 

15H TA M 2 Temperature TA (defrosting temperature) 

17H RF M 1 Relative humidity in % 

20H T1MIN P 2 Set point T1min (room temperature 
minimum) 

21H T1MAX P 2 Set point T1max 

22H TVMIN P 2 Set point TVmin 

23H TVMAX P 2 Set point TVmax 

24H ALMIN P 2 Set point ALmin (alarm minimum) 

25H ALMAX P 2 Set point ALmax (alarm maximum) 

26H TGVMIN P 2 Set point TGVmin (glycol minimum) 

27H TGVMAX P 2 Set point TGVmax (glycol maximum) 

28H THMIN P 2 Set point THmin (heating minimum) 

29H THMAX P 2 Set point THmax 

2AH RFMIN P 1 Set point RFmin (relative humidity 
minimum) 

2BH RFMAX P 1 Set point RFmax 
 

Agri Controller 2500 (AC2500) 

PC Name Cat. Length Description 

00H PING E - Test if device is ready, empty reply 

01H RESET E - Reset the device 

0BH TROOM H* 1 Sets the room on which the following 
parameters reference to 

0DH GCO2 M 1 Measured CO2 value of actual room 

0EH GO2 M 1 Measured O2 value of actual room 

0FH GROOM M 1 Actual (last measured) room 

1DH RLZ M 32 All running times 
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22H RSTATE P 1 State of the room (0-3) reference to 
TROOM 

23H RCO2MAX P 1 CO2 Maximum reference to TROOM 

24H RCO2NOM P 1 Set point CO2 reference to TROOM 

26H RO2MIN P 1 O2 Minimum reference to TROOM 

27H RO2NOM P 1 Set point O2 reference to TROOM 

68H GCYCLEID M 4 Measure cycle number (continuous) 

69H GP M 2 Analyzed air pressure 

1000H LZADSO M 2 Running time adsorber in reference to 
TROOM 

1001H FQADSO M 2 Running frequency adsorber in reference to 
TROOM 

1002H LZAIR M 2 Running time air valve in reference to 
TROOM 

1003H FQAIR M 2 Running frequency air valve in reference to 
TROOM 

1004H LZOXI M 2 Running time N2 generator in reference to 
TROOM 

1005H FQOXI M 2 Running frequency N2 generator in 
reference to TROOM 

1F02H DATTIM P 6 Date and time (Y, M, D, Hour, Min, Sek) 

 
Energy Econom (EC55/EC100) 

PC Name Cat. Length Description 

00H PING E - Test if device is ready, empty reply 

01H RESET E - Reset the device 

03H PORT M 2 State of the output ports 

04H STATUS M 1 State of the device 

06H STORE E - Store parameters to the eeprom 

11H P M 2 Actual measured power consumption 

16H PMAX P 2 Set point maximal power consumption 

 
Sequencer (CMP8/16/4+4GL/2+2GL) 

PC Name Cat. Length Description 

00H PING E - Test if device is ready, empty reply 

01H RESET E - Reset the device 

03H PORT M 2 State of the output ports 

04H STATUS M 1 State of the device 

06H STORE E - Store parameters to the eeprom 

14H RUNMAP M 2 Shows in a bit mask what 
compressors/steps are running 

15H ERRMAP M 2 Shows in a bit mask what 
compressors/steps have errors 

 
 

Device Configuration 

Because there are multiple devices that use the AGRIs protocol, we cannot define a standard device 

configuration.  
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Executing the Driver  

After adding the AGRI driver to a project, Studio sets the project to execute the driver automatically when you 

start the run-time environment.  

To verify that the driver run-time task is enabled and will start correctly, perform the following steps: 

1. Select Project → Status from the main menu bar. 

The Project Status dialog box displays, as follows.  

 

Project Status Dialog Box 

2. Verify that the Driver Runtime task is set to Automatic. 

If the setting is correct, click OK to close the dialog box.  

If the Driver Runtime task is set to Manual, select the Driver Runtime line. When the Startup button becomes 
active, click the button to toggle the Startup mode to Automatic.  

3. Click OK to close the Project Status dialog.  

4. Start the application to run the driver. 
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Troubleshooting 

If the AGRI driver fails to communicate with the device, the tag you configured for the Read Status or Write Status 

fields will receive an error code. Use this error code and the following table to identify the failure that occurred.  

 

Error 

Code 
Description Possible Causes Procedure to Solve 

0 OK  Communication without problems  None required. 

7 Wrong Device Name  The device name in Header field is wrong  Type a valid device name. 

8 Wrong Register Address 
 The address type in Address field is 

wrong 
 Valid addresses are 0 to 65535. 

10 Invalid Parameter 
 The address in the Address field is not 

valid to the PLC type. 
 See the device specifications. 

-15 Timeout Start Message 

 Disconnected cables 
 PLC is turned off, in stop mode, or in error 

mode 
 Wrong station number 
 Wrong RTS/CTS control settings 

 Check cable wiring. 
 Check the PLC state – it must be RUN. 
 Check the station number. 
 Check the configuration. See Studio 

Technical Reference Manual for 
information about valid RTS/CTS 
configurations. 

-17 Timeout Between rx Char 

 PLC in stop mode or in error mode 
 Wrong station number 
 Wrong parity 
 Wrong RTS/CTS configuration settings 

 Check cable wiring. 
 Check the PLC state – it must be RUN. 
 Check the station number. 
 Check the configuration. See Studio 

Technical Reference Manual for 
information about valid RTS/CTS 
configurations. 

 

 

 Tip:  

You can verify communication status using the Studio development environment Output window (LogWin 

module). To establish an event log for Field Read Commands, Field Write Commands and Serial Communication, 

right-click in the Output window. When the pop-up menu displays, select the option to set the log events. If 

you are testing a Windows CE target, you can use the Remote LogWin of Studio (Tools  Remote Logwin) to 

get the log events from the target unit remotely. 

 

If you are unable to establish communication with the PLC, try to establish communication between the PLC 

Programming Tool and the PLC. Quite frequently, communication is not possible because you have a hardware 

or cable problem, or a PLC configuration error. After successfully establishing communication between the 

device’s Programming Tool and the PLC, you can retest the supervisory driver. 

To test communication with Studio, we recommend using the sample application provided rather than your new 

application. 

If you must contact us for technical support, please have the following information available: 

 Operating System (type and version): To find this information, select Tools → System Information.  

 Studio version: To find this information, select Help → About. 
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 Driver Version: To find this information, read the full description of the driver on the Communication Drivers 

Dialog Box. 

 Communication Log: Displays in the Studio Output window (or LogWin window) when the driver is running. Be 

sure to enable the Field Read Commands, Field Write Commands and Serial Communication for the LogWin window. 

 Device Model and Boards: Consult the hardware manufacturer’s documentation for this information. 
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Sample Application 

 

You will find a sample application for drivers in the /COMMUNICATION EXAMPLES/AGRI directory. We strongly 

recommend that you check for a sample application for this driver and use it to test the driver before configuring 

your own customized application, for the following reasons: 

 To better understand the information provided in each section of this document. 
 To verify that your configuration is working satisfactorily. 
 To certify that the hardware used in the test (device, adapter, cable and PC) is working satisfactorily before 

you start configuring your own, customized applications. 
 

Note:  

This application sample is not available for all drivers.  

 

Use the following procedure to perform the test: 

1. Configure the device’s communication parameters using the manufacturer’s documentation. 

2. Open and execute the sample application. 

 Tip:  

You can use the sample application screen as the maintenance screen for your custom applications.  
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Revision History  

 

Doc. 

Revision 

Driver 

Version 
Author Date Description of changes 

A 1.01 Luis F. Espinosa C. Jul/30/1999 First version of the driver 

B 1.02 Eric Vigiani Sep/28/2004 Implement command 00H allowing the user to specify the target address. 

C 1.03 Eric Vigiani May/02/2005 Modified AGRI driver to accept parameters code. 

D 1.04 Eric Vigiani Aug/10/2005 Fixed read problems. 

 
 


